Introduction to \textit{STATISTICA}: Graphs and Macros (SVB)
Purpose of Training

Learn how

- To use the different types of graphs available in STATISTICA
- To use the various graph tools to further study and visualize your data
- To customize the components of a graph
- To use graph styles
Types of Graphs

*STATISTICA* offers facilities to convert almost any dataset into a wide variety of graphical representations via a large selection of graph definition and customization options.

- Integrated Graphs (Analyses Graphs)
- Graphs of Input Data
- Graphs of Block Data
- Graphs Menu
- User-defined Graphs
Integrated Graphs

In *STATISTICA*, the quickest graphs are the predefined or “integrated” graphs that accompany almost all analyses. These graphs use appropriate data from their associated analyses, can be made with a single click of a button, and always present relevant information in the context of the analysis being performed.

All other graphs allow varying degrees of user input in specifying the features of the graph to be created.
Graphs of Input Data

Graphs of Input Data are available from the shortcut menu accessed by right-clicking on any spreadsheet cell, from the Graphs menu, or by selecting Graphs from the Start Button menu.
Graphs of Input Data

- Offer rapid summaries of data from input data spreadsheets.
- Include the most commonly used graphs, but default formats of the graphs are produced to minimize requirements for selection of additional options.
- Take into account current input spreadsheet case selection and weighting conditions.
Example 17: Graphs of Input Data

View your output in individual windows. This makes it easier to compare graphs. To adjust the output format, select **Output Manager** from the **File** menu. Select the **Individual Windows** option button, and then click the **OK** button.

Use **Characteristics.sta**.
Example Steps

1. Right-click in any cell in the *Height (in)* column. Select *Graphs of Input Data - Histogram Height (in) - Normal Fit*.

2. Right-click any *Height (in)* cell. Select *Graphs of Input Data - Scatterplot by - Regression, 95% conf.* Select *Weight (lb)* as the second variable and click the *OK* button to produce the graph.
Example Steps

3. From the **Statistics** menu, select **Basic Statistics/Tables**. Double-click **Correlation matrices**. **One variable list**, and select variables 4 through 12. Click **OK**, then click **Summary**.

4. In the spreadsheet, right-click the intersection of **Weight (lb)** and the **Age (yr)**. Select **Graphs of Input Data - Scatterplot by Age (yr) - Regression, 95% conf.**
Graphs of Block Data are available from the shortcut menu accessed by right-clicking on any spreadsheet cell, from the Graphs menu, or by selecting Graphs from the Start Button menu.
Graph of Block Data

- Draw their input from selections in the currently active spreadsheet.

- Useful as quick aids for visualizing analysis results as well as exploring relationships among subsets of data.

- Intermediate in flexibility and simplicity of definition between Graphs menu graphs (see the following section) and Graphs of Input Data described above.

- Ignore any spreadsheet case selection or weighting conditions that have been specified.

- Use the cursor position or an actual highlighted (continuous) block of data in the active spreadsheet to define input data for the graph.

- Can be specified to address data in either a column-wise or row-wise fashion from the highlighted block, or they can address entire rows or columns of data defined by the columns or rows within the selected block.
Graphs of Block Data

The upper section of the Graphs of Block Data submenu contains a set of predefined default graphs that can be immediately produced by a single mouse-click. These default graphs have descriptive names that identify whether they operate on entire columns of data or on selected blocks of data (addressed either by rows or by columns).
The next section of the **Graphs of Block Data** submenu contains four **Custom Graph** commands that address block graphs (by row or by column) and graphs that use entire rows or columns of the spreadsheet as input.

Select one of the four options to display the **Select Graph** dialog, which is used to specify a wide variety of alternative graphs that are a subset of the graphs available under **Graph** menu graphs. The selected graph will then be produced in the manner specified using the variable or variables defined by the cursor position or block of data selected in the spreadsheet.
Example 18: Graphs of Block Data

Using the *Characteristics.sta* data file, select **Basic Statistics/Tables** from the **Statistics** menu. On the **Basic Statistics and Tables** dialog, double-click **Descriptive statistics**. Click **Variables** button, and select variables **Height (in)** through **Test Item (3)**. Then click the **OK** button.
Example Steps

1. Click the **Summary** button to produce the **Descriptives Statistics** spreadsheet.

2. Highlight the block of data corresponding to the **Mean**, **Minimum**, and **Maximum** for **Test Item 1**, **Test Item 2**, and **Test Item 3**. Right-click inside the block and select **Graphs of Block Data - Custom Graph from Block by Column**. Select **2D Graphs-Range Plots-Whisker - absolute**. Click **OK**.
Example Steps

3. Sort the data (*Data–Sort*) by *Hair Color*, then select the block of *Height (in)* and *Weight (lb)* data for red hair. Right-click inside the block and select *Graphs of Block Data*. Select *Custom Graph from Block by Column*. Specify *2D Graphs - Scatterplots - Linear Regression, 95%*. Select the *Add to Graph menu List* check box and click *OK*. Name the graph *MyScatterplotBlkByCols* and click *OK*. 
4. Right-click in any highlighted block and note that your newly defined graph type has been added to the list of **Graphs of Block Data**.

5. Select **Customize List** to display the **Customize Graph Menu** dialog. This dialog is used to modify the listings in the first section of the menu as well as add new predefined graphs of your own choosing defined using the **Select Graph** dialog.
Graphs Menu

The most flexible graphing capabilities available in STATISTICA, offering literally thousands of different combinations of options to create the precise graphics that lead to accurate interpretation of data as well as the bold and concise graphics necessary for clear communication of results.

- Available from the Graphs menu or from the STATISTICA Start Button
- Process data directly from the current input spreadsheet
- STATISTICA takes into account current case selection and weighting conditions for the variables to be plotted as it generates Graphs menu graphs.
Graphs Menu Categories

- 2D Graphs,
- 3D Sequential Graphs,
- 3D XYZ Graphs,
- Matrix Plots,
- Icon Plots, and
- Categorized Graphs
Graph Definition Dialogs

- The **Quick** tab contains a limited assortment of the most-commonly-used options.

- The **Advanced** tab contains a complete set of options that are applicable under most circumstances for defining the detailed architecture of the selected graph type.

- The **Appearance** tab contains options to select a graph subtype, a saved **Graph Style** to use as a template, and a predefined **Document Style** to govern the graph’s general format as it will appear when printed.

- The **Options 1** and **Options 2** tabs provide access to a number of less-frequently-used options that govern graph appearance.
Example 19: Graphs Menu

**Graphs** menu graphs contain the most options of any STATISTICA graphing approach but, as this example illustrates, that does not mean that they take a great deal of time or energy to specify.

Use *Characteristics.sta*. 
Example Steps

1. From the **Graphs** menu select **3D Sequential Graphs - Bivariate Histograms**. On the **3D Bivariate Histograms - Quick** tab, click **Variables** and specify **Hair Color** as the X-axis variable and **Eye Color** as the Y-axis variable. Then click **OK** (twice) to produce the graph.

After the graph is drawn, use the **3D Rotation control** button to position the graph for best interpretation.
2. Let us suppose we would like to observe the distribution in males versus females of general well being as measured by the Wellness 1 variable in our Characteristics.sta data file. Let us further suppose that we would like to get a feeling whether this distribution of well being changes with age.

a. With the Characteristics.sta data file active, select Means w/Error Plots from the Graphs menu. On the Means with Error Plots – Quick tab, click the Variables button and select Wellness 1 as the dependent and Gender as the grouping variable from the selection dialog. Leave all of the remaining options on the Quick tab at their default values to produce a plot of means with 95% confidence intervals about the means for Wellness 1 in males versus females. Click OK.
b. Resume the analysis by selecting **Resume** from the **Graphs** menu. Click the **Categorized** tab. Under **X-Categories** select the **On** check box, click **Change Variable**, and specify **Age (yr)** as the variable to use for categorization. We can specify boundary values by selecting the **Boundaries** option button under **X-Categories**.

c. When the **Boundaries** option button is selected, the button at the bottom of the list under **X-Categories** becomes a **Specify Boundaries** button. Click this button to display a dialog on which we can enter the boundaries to define our categories. Enter 40, then a space, then 60 in the **Enter Upper Boundaries** box and then click **OK** to close the dialog.
Example Steps

d. Finally, click **OK** on the *Means with Error Plots* dialog to produce the graph.

In terms of the measure of well being provided by *Wellness 1*, it appears that the relative well being in males versus females is similar in the three age groups we have defined.
User-Defined Graphs

The **Add as User-defined Graph to Menu** option on the **Options 2** tab of the definition dialogs for all **Graphs** menu graphs is used to save all of the options specified during graph definition (including variable selection) for later recall and use with the same or a different input spreadsheet to create similar graphs with no additional specification.

Once saved, these graph “templates” can be accessed from the **User-defined Graphs** command on the **Graphs** menu.
Example 20: User-Defined Graphs

Specialized graphing tasks that need to be repeated for a number of similar data files or for repeated graphing of similar variable relationships within a single data file can often be addressed by a User-Defined Graph.

Use Characteristics.sta.
Example Steps

1. Select **Scatterplots** from the **Graphs** menu. On the **2D Scatterplots** dialog, **Quick** tab, click the **Variables** button and specify **Height (in)** as the **X** variable and **Weight (lb)** as the **Y** variable. Click **OK**. Now move to the **Advanced** tab and click the **Mark Selected Subsets** button to display the **Specify Multiple Subsets** dialog. Enter the information shown at left, then click **OK**.
Example Steps

2. Select the **Options 1** tab of the **2D Scatterplots** dialog. In the **Custom title** box, enter **Hair Color Property (red/brown)**. Click **OK** to create the graph.

3. Press **CTRL+R**, then select the **Options 2** tab. Click **Add as User-defined Graph to Menu** and enter **HairColorScatterplot** to identify the graph type. Clear the **Save variables** check box and click **OK**. **Cancel** the **2D Scatterplots** dialog.
4. Select **Graphs – User-defined Graphs – HairColorScatterplot**. Review the different tabs of the dialog, and verify that the options are still specified.

5. On the **Quick** tab, select **Test Item 3** as the *X* variable and **Test Total (Avg)** as the *Y* variable. Click **OK**. Then click **OK** to create the graph.
Auto Updating Graphs

- Graphs can be set to update automatically whenever the data are updated (Excludes all Analyses graphs except those available in QC).
- Changes made to the graph (via brushing tools) can be updated to the spreadsheet.
- As changes are made in one graph to brush and exclude and/or label data points, changes are instantly made in all the graphs based on that spreadsheet.
- Note that Analyses graphs are not brushable in the same way as *Graphs* menu graphs, *Graphs of Block Data*, and *Graphs of Input Data*. 
Specifying Update Options

You can **Update from Spreadsheet** *Automatically* or *Manually* or mark the graph as **Locked** so it cannot be updated.

You can also **Update from Analysis Dialog** and **Update when input data changes**.
Example 21: Auto Updating Graphs

Suppose we suspect that some of the Weight (lb) and/or Height (in) data were incorrectly entered in the Characteristics.sta data file. We can interactively explore the data graphically by activating STATISTICA’s Auto Updating facility.
Example Steps

1. Select **Graphs-Scatterplots**. On the **Quick** tab, click **Variables**, and specify **Height (in)** as the **X** variable and **Weight (lb)** as the **Y** variable. Click **OK**. On the **Options 1** tab, select the **Update from Spreadsheet** check box and select **Auto**. Click **OK**.

Notice the two low weight scores. They were entered incorrectly.
Example Steps

2. Scroll the spreadsheet to view the *Weight (lb)* column for Case 33. Enter 180 in the appropriate cell. Disregard the warning dialog. Change the *Weight (lb)* value for case number 88 to 187.

Note by comparing with the previous plot, that the Y-axis scaling has changed to reflect the new data range, and that the linear fit line (and its displayed equation) have been modified slightly to reflect the new values.
Global Graph Options

Global graph options can be set on the Options dialog (Select **Tools – Options**)

- Analyses/Graphs tab
- Graphs 1 tab
- Graphs 2 tab
- Configuration Manager tab
Compound/Multiple Graphs

Compound graphs include

- **Graphs** menu graphs that display different graph types on a single graph, such as Scatterplots with Box Plots, Scatterplots with Histograms, and Matrix graphs
- Categorized graphs
- Specialized graphs from statistical analyses (e.g., X-bar and R charts)
- Compound graphs specified via the **Wizard** or **Templates** options

The first three types are created by **STATISTICA**, and the last type is a user-defined graph category.
Wizard and Templates

Select **Wizard** to create a compound graph using a variety of
- Previously saved graphs
- Currently open graphs
- Blank “placeholder” graphs

Select **Templates** to arrange a set number of blank “placeholders” which can later be filled with **STATISTICA** graphs or graph objects.
Example 22: Using the Wizard

To do this example, you must direct all output to individual windows. From the *Tools* menu, select *Options*. On the *Output Manager* tab, select the *Individual Windows* option button, and click *OK*.

Use *Characteristics.sta*. 
Example Steps

1. Right-click anywhere in the **Test Item 1** column. From the resulting shortcut menu, choose **Graphs of Input Data - Histogram Test Item 1 - Normal Fit**.

2. Repeat step one creating graphs to be placed in individual windows for **Test Item 2**, **Test Item 3**, and **Test Total (Avg)**. You should have four graphs in individual windows.
Example Steps

3. From the **Graphs** menu, select **Multiple Graphs Layout - Wizard**. On the **AutoLayout Wizard – Step 1** dialog, click **All Windows**. Click the **Next** button to display the **AutoLayout Wizard – Step 2** dialog. Select the layout format shown at right. Also select the **Title** checkbox under **Create**.

4. Click **Finish**. Double-click the **Title** and change it to **SUMMARY OF TEST ITEMS**.
Customizing Graphs after Creation

All STATISTICA graphs can be similarly and extensively customized after creation.

In STATISTICA, there are three major types of graph customizations available:

- Adding/editing custom and other graphic objects,
- Customizing the components of a graph, and
- Using graph styles for graph customization.
Adding/Editing Custom and Other Graphic Objects

Use the *Graph Tools* toolbar or *Insert* menu to

- Add text, rectangles, rectangles with rounded corners, circles or ovals, arcs, polygons or freehand lines, and arrows to any *STATISTICA* graph as movable and customizable objects

- Insert preexisting graphic objects from *STATISTICA* or other applications either as embedded or linked objects
Dynamic vs. Fixed

Objects are in fixed coordinate mode, (i.e., they will maintain their relative position with respect to the graph window dimensions) when initially placed on a graph. Using the Properties dialogs, objects can be easily converted to a Dynamic coordinate mode in which they will maintain a position that corresponds to the set of graph axis coordinates at which they are placed.
Example 23: Adding Custom Objects

1. Use Characteristics.sta to create a scatterplot of Age (yr) vs. Height (in).

Note that there are two data points at Height (in) values of 57 and 58 near the bottom of the plot. We would like to call attention to this height-age information by labeling the points with the names of the participants in the study.
Example Steps

2. Maximize the graph and click the **Arrow** drawing tool on the **Graph Tools** toolbar. Place the cursor to the right of the rightmost of the two points, press the mouse button, and drag a short arrow upward and to the right. The arrow shaft will be terminated when the mouse button is released.

3. Click the **Text** button and left-click near the tail of the arrow. Double-click the words *Custom Text* and change them to *MARY*. Click **OK**, then right-click *MARY* and select **Text Object Properties**. Select the **Dynamic** check box and specify the **Left, Bottom** to be the **Anchor Point** for the box. Click **OK**.

4. Repeat these two steps to mark the point on the left with an arrow and a label (*BOB*) placed above and to the left of the point. When you place the arrow, clear the **Dynamic** check boxes on the **Arrow Object Properties** dialog, and leave the **Dynamic** checkbox cleared on the **Text Object Properties** dialog.
Example Steps

5. Our graph should look like the graph at left.

6. Let’s preview customization of individual components by changing the x-axis scale. Double-click the X-axis line to display the **Axis Layout** dialog. On the **Scaling** tab, change the **Mode** from **Auto** to **Manual**. Enter 0 and 100 as the **Minimum** and **Maximum** scale values. Click **OK**.

7. Note that the **Fixed** arrow is no longer in the correct location.
Customizing the Components of a Graph

The components of all STATISTICA graphs are readily customizable after creation. The same plot customization options are available for integrated graphs, Graphs menu graphs, Graphs of Input Data, and Graphs of Block Data.

3 Ways to Access
- Double-click the object
- Right-click the object and select options from a shortcut menu
- Use the All Options graph customization dialog
All Options

Accessible from the **Format** menu, from any graph shortcut menu (select **Graph Properties (All Options)**), or by double-clicking anywhere in the graph background

Contains a number of tabs (usually from 15 to 20) that address all of the relevant customizable features for the particular graph type from which the dialog was invoked
Customizable Features

To illustrate a few of the more important customizable features, let’s create a simple scatterplot using the Characteristics.sta data file. Select Scatterplots from the Graphs menu, and on the Quick tab of the 2D Scatterplots dialog, specify to make a Multiple type scatterplot using Height (in) as the X variable and Weight (lb) and Age (yr) as the Y variables.
Example 24: Background Colors and Axis Proportions

1. On the All Options dialog Graph Window tab, select a light blue outer background and a light yellow inner background color for the graph (Hint: Use the More colors option to define an appropriate light shade of yellow).
2. On the same tab, select the check box under **Borders around the graph**; then click the **Borders** button to display the **Line Properties** dialog. Change the line thickness to 3 points and click the **Close** button.

3. Click the **Graph Layout** tab and select **Equal** from the **Axis proportion** drop-down list. Click **OK** at the bottom of the **All Options** dialog to redraw the graph displaying the new features.
Example 25: Titles

1. On the **All Options** dialog, **Graph Titles/Text** tab, change the title of the graph to **HEIGHT/WEIGHT/AGE RELATIONSHIPS** in the text-editing window. Specify the title to be centered and the font to be bold using the toolbar buttons above the window.
Example Steps

2. Next, select the graph **Subtitle** from the drop-down list below the text-editing window. Now clear the **Display** check box just above and click the **OK** button at the bottom of the dialog to redraw the graph.
Example 26: Plot: General tab

The **Plot: General** tab provides access to all of the individual plots on a graph. On this tab, the display of individual plots can be turned on and off, and complete customization of colors, type, and size (if applicable), for any point markers, lines, or area patterns that are integral parts of the plot are available. New plots can also be added to the graph from this tab.
Example Steps

1. On the **Plot: General tab**, select **1: Weight (lb)** in the **Plot** box and then click the **Markers** button. On the **Marker Properties** dialog, select a solid-filled (blue) circular marker and then click **Close** to close the dialog.

2. Next select **2: Age (yr)** in the **Plot** box and again click the **Markers** button. This time select a solid-filled (red) square marker. Once again, close the **Marker Properties** dialog and click **OK** to redraw the graph.

Note that the point marker characteristics change in the graph legend as well as in the body of the graph.
Point Labels, Fitting, and Regression Bands

- Use the **Plot: Point Labels** tab to plot case name labels and/or $X$ and $Y$ coordinate values.

- Use the **Plot: Fitting** tab to add, delete, and/or customize any number of predefined fits to individual 2D and 3D plots.

- Use the **Plot: Regr. (Regression) Bands** tab to either add or customize **Confidence** limits or **Prediction** limits for Linear and Polynomial fit functions present on the graph.
Example 27: Fits, Labels, Bands

1. On the **Plot: Fitting** tab of the **All Options** dialog, select **1: Weight (lb)** from the **Plot** drop-down list, and then choose **Polynomial** from the **Fit type** drop-down list to change the current **Linear** fit (**Fit 1**) to polynomial.
Example Steps

2. Then select 2: Age (yr) from the **Plot** drop-down list, and click the **Add new fit** button. Note the **Fit** box displays a 2. Specify that a polynomial fit type be applied by setting the fit to **Polynomial** in the **Fit type** box. Also change the **Line Pattern** color from red to green.

3. Click the **Plot: Regr. Bands** tab. Select 1: Weight (lb) from the **Plot** drop-down list; next, select **Fit 1** and click **Add new pair of bands**. Accept all defaults and click **OK**.
Example 28: Plot: Ellipse tab

Available only for 2D graphs that display bivariate data, the *Plot: Ellipse* tab provides addition or customization of any desired number of *Normal* or *Range* type data ellipses to each plot on the graph. These plots can serve as aids to visualize potential outliers, provide a prediction interval in which additional sample points might be expected to fall, or display the relative ranges of values for a variable pair.
Example Steps

1. On the **Plot: Ellipse** tab, select 2: Age (yr) from the **Plot** drop-down list, and click the **Add new ellipse** button. Change the value in the **Coefficient** box to 0.95 and accept all other defaults. Now click **OK** at the bottom of the dialog to add a normal, 95% confidence ellipse to the plot of **Height (in) versus Age (yr)**.
Axis: tabs

Use the **Axis**: tabs to make customizations to each axis in the graph

- **Axis: Title** tab
- **Axis: Scaling** tab
- **Axis: Major Units** tab
- **Axis: Minor Units** tab
- **Axis: Scale Values** tab
- **Axis: Custom Units** tab
- **Axis: General** tab
Example 29: Axis: tabs

1. On the **Axis: Title** tab, select the X-axis in the **Axis** box and change the title to **HEIGHT IN INCHES**. Keep the title centered, but change the font to bold, 12 point using the toolbar buttons on the tab.

2. On the **Axis: Scaling** tab, select the X-axis in the **Axis** box and change the **Mode** from **Auto** to **Manual**. Then specify a **Minimum** value of 50 and a **Maximum** of 80.
Example Steps

3. Select the Y left axis in the Axis box and similarly set the Auto mode to Manual with a Minimum value of 0 and a Maximum of 300.

4. On the Axis: Major Units tab, specify the Y left axis in the Axis box. Change the Mode from Auto to Manual and specify the Step size to be 50.

5. Finally, click OK at the bottom of the All Options dialog to redraw the graph with its adjusted axis scaling and labeling.
Example 30: Custom Function tab

The **Custom Function** tab on the **All Options** dialog allows addition of any number of user-specified functions (e.g., $Y=-2X + X^2$ or $Z=3X^2 - 2Y^3 + 48$) to the graph. Each function can be applied over a specified range of $X$ values (or $X$ and $Y$ values in the case of 3D plots).
Example Steps

1. On the **Custom Function** tab, click **Add new function**. In the \( Y = \) function window add \( 2 \times X - 10 \). Click **OK**.

2. On the **Graph Titles/Text** tab, select **Floating** from the **Status** drop-down list. Then on the toolbar, click the **F=** button. Select **Function 1** from the list. Click **OK**.

3. Click on the function and drag it to the right margin area near the function line.
Using Graph Styles

- Graph styles are saved sets of options that can be quickly applied to change the appearance of a variety of graph features simultaneously.

- A graph with an applied style can be sent to another STATISTICA user and its features will be correctly interpreted even though the user has not defined an equivalent graph style.
Example 31: Graph Styles

1. Create a 2D histogram using the *Characteristics.sta* data file and variable *Test Total (Avg)* accepting all default values. Then double-click in the margin of the histogram to display the *All Options* dialog.
Example Steps

2. On the **Graph Windows** tab, change the color of the outside background to black. On the **Graph Titles** tab, change the **Title** and **Subtitle** colors to white. Then select the **Plot: Bars** tab and click the **Area** button. On the **Area Properties** dialog, select the second (blank) pattern in the **Area pattern** matrix and set the **Foreground color** to black.
3. Next, on the **Axis: Scale Values** tab select X-axis in the **Axis** box; then click **Font**. On the **Font** dialog under **Effects**, set the **Color** to white. Click **OK** to close the **Font** dialog and repeat the steps for the Y left-axis.

4. On the **Axis: Titles** tab change the color of the font to white for both the X and Y left axes. Finally, click **OK** at the bottom of the **All Options** dialog.
Example Steps

5. Right-click the **Graphics Styles** box on the **Graph Tools** toolbar. Choose **Save As** and give the style a name (e.g., **HistogramB&W**) in the **Style name** box. Click **Save**.

6. Close the graph and create a new histogram using the variable **Weight (lb)**. From the list of graph styles available in the **Graphics Styles** box, select the new (**HistogramB&W**) style to apply it to the just-created graph.
STATISTICA contains a variety of tools for interactive exploration of graphic data. We have already discussed the use of *Auto updating* as an exploratory tool in a previous section. This section will address the use of the *Zoom, Brushing*, and *Rotation* features as additional tools for data exploration.
The Zoom Tool

**Zoom in** on a specific area of a 2D or 3D graph to be magnified by either clicking the mouse on the center of the area you wish to magnify or by dragging a rectangle to define the area of interest.

**Zoom out** to “undo” the magnification applied by the **Zoom in** tool.

**Zoom reset** will remove all magnification.
Example 32: Zoom

1. Using the Characteristics.sta data file, make a 2D Scatterplot using the Height (in) variable on the X-axis and the Weight (lb) variable on the Y-axis.
Example Steps

2. Click the **Zoom in** button on the toolbar, and place the mouse pointer approximately in the center of the cluster of points at \( \text{height} = 69 \text{ inches} \) and \( \text{weight} = \text{about 200 lbs} \). Then click to magnify and increase the resolution of the graph.

3. Next, click the **Zoom out** button to return the graph to its original state.
Brushing Tool

The **Brushing** dialog contains tools for identifying points or groups of points on both 2D and 3D graphs to be marked, labeled, excluded, or hidden.

- Select/highlight either individual points or groups of points
- Use the **Slice X**, **Y**, and **Z** and the **Cube** options to define areas on a 2D or 3D plot or volumes on a 3D plot
- Animate selections to explore the spatial distribution of values
Example 33: Brushing

1. Make a 2D scatterplot with Height (in) as the X variable and Weight (lb) as the Y variable using the Characteristics.sta data file.
2. Activate the brushing tool. Click the mouse pointer on the two low-weight isolated points at the lower part of the graph corresponding to heights of 67 and 70 inches. On the **Brushing 2D** dialog, select the **Label** option button under **Action**. Finally, click the **Apply** button to see which cases correspond to the two highlighted points.
Example 34: Animated Brushing

1. Use Characteristics.sta data file, and select Matrix Plots from the Graphs menu. Accept all of the default options on the Quick tab and specify variables Test Item 1, Test Item 2, and Test Item 3. Then click the OK button to create the plot.
Example Steps

2. Click the **Brushing** toolbar button, and select the **Box** option button under **Selection Brush**. On the scatterplot in the center of the top row of graphs, drag a rectangular box around several points.

3. Now click the **Animate** button on the to set the selection box in motion to explore additional corresponding points.

Note that in addition to points highlighted in the graph in which the box was drawn, points with corresponding values are also highlighted in the other scatterplots in the matrix.
Automatic Updates and Interactive Brushing

Recall that STATISTICA includes an **Automatic Data Update** mode. When this mode is selected, all **Graphs** menu graphs will be automatically updated when the data change.

Additionally, case states (including case labels, case excluded, case hidden, marker color, etc.) made in **Graphs** menu graphs can be automatically updated back to the spreadsheet. When the **Update spreadsheet case states** option is selected, the spreadsheet upon which the current graph is based will have the same case states as in the graph.

This means that you can use the brushing tool to label (mark, exclude, etc.) points in one graph, have those same changes reflected in the spreadsheet and, then, in turn, label (mark, exclude, etc.) the same points in all other connected graphs simultaneously.
Example 35: Interactive Brushing

This example will illustrate many of the brushing and data update features within STATISTICA. As with previous examples, you will need to output your graphs to individual windows rather than a common workbook. STATISTICA’s default settings are appropriate for this illustration, but let’s review what those settings are.
Example Steps

1. From the **Tools** menu, select **Options** to display the **Options** dialog and click on the **Graphs 2** tab. In the **Data Update** section verify that the **Initial update mode** is set to **Automatic**, select the **Update spreadsheet case states** check box, and set the **Case states/names for multiple plots** to **Common**.

2. Using **Characteristics.sta** create a 2D histogram using the variable **Wellness 1**.
3. Now create a scatterplot using *Wellness 1* as the *X* variable and *Wellness 2* as the *Y* variable.

4. Return to the histogram, and click the brushing tool. On the *Interactive* tab, select the *Label* option button (leave all other options at their default). With the brushing tool, select the four columns to the right of 60 in the histogram (i.e., all cases which had a 60 or higher in *Wellness 1*).

Notice that as the columns are highlighted in the histogram, the corresponding cases in the spreadsheet are also highlighted.
Example Steps

5. Click the **Apply** button on the **Brushing 2D** dialog to complete the labeling of the selected points. Because individual points are not displayed in the histogram, you cannot see the labels; however, you can see the labels in the spreadsheet and in the scatterplot.

Notice that cases with a **Wellness 1** score greater than 60 now have a label icon in the case name column, and all cases with a **Wellness 1** score greater than 60 are labeled in the scatterplot.
6. Let’s see how changes in the spreadsheet affect attached graphs. In addition to marking, labeling, excluding, or hiding points in graphs via the brushing tool, you can also change the case state within the spreadsheet. To see this, right-click in the case name for case 1. On the shortcut menu, notice that the Label option is selected. This is because case 1 has a Wellness 1 score of 61.134.
7. To quickly locate this point, let’s select the **Marked Points** option. In the spreadsheet, case 1 now has a red exclamation (the icon used for marked points). In the scatterplot, the point marker for case 1 is now a filled blue circle.

8. Return to the histogram and quit brushing. Right-click in the graph background, then select **Graph Data Editor** from the shortcut menu.

Our changes have also been reflected in the data used for the histogram. Notice the case state for case 1 shows the label and marked point icons.
Example Steps

9. Save the histogram, then close the graphs and spreadsheet. Open the histogram, and use the brushing tool to mark the first two columns. (You will need to select the **Mark** option button on the **Brushing 2D** dialog.)

Open the **Graph Data Editor** for the histogram. Notice that the case state for case 7 is now marked.

10. Open **Characteristics.sta**. Note that case 7 is not marked in the data set.
Example Steps

11. Double-click the background of the histogram to display the **All Options** dialog. Select the **Graph Layout** tab, and look at the **Reconnect on load** option. By default, a reconnection will be made between the graph and the spreadsheet only if the spreadsheet is open. This option can also be set to **Always** reconnect, **Always ask** before reconnecting or **Never** reconnect.

Why didn’t the spreadsheet reflect the changes made to the histogram?
12. Click the **Details** button on the **Graph Layout** tab to display the **Data Update Details** dialog. This dialog contains options to adjust the spreadsheet data source and variable selection used for the graph.

13. Use the **Break link with this file** option to disconnect the graph from the data file or use the **Change file** option to connect the graph to a different data file.
Example 36: Analyzing Data Via Brushing

This example will illustrate how the brushing tools can be used to visually analyze data.

Open the Titanic.sta data file.
1. From the **Graphs** menu, select **Histogram** and create a histogram using **Survival** as the variable. In the **Fit type** box, clear the **Normal** check box. Click **OK**.

2. From the **Graphs** menu, select **Categorized Graphs – Histograms**. On the **Quick** tab, click **Variables** and select **Class** as the **Variable** and **Gender** as the **X-category**. Click **OK** (twice) to create the graph.
Example Steps

3. Create two more categorized histograms, one using Survival by Gender, and the other using Gender by Class and Survival.

4. Minimize the spreadsheet, and from the Window menu select Tile Vertically.

5. Click the brushing toolbar button to display the 2D Brushing dialog. In the Selection Brush section, select the Box option button.
6. First, let’s look at males. In the Survival by Gender graph, select the bar representing male survivors. Note that about half the survivors were Male and the majority of the male survivors were either crew members or third class passengers.

7. Now, look at missing males. Of those missing, about 90% were male. Almost 80% of the male crew members were reported missing.
8. Now look at females. Select the bar representing female survivors. Virtually all female 1\textsuperscript{st} and 2\textsuperscript{nd} class passengers and female crew members survived while less than \(\frac{1}{2}\) the 3\textsuperscript{rd} class passengers survived.

9. Now, look at missing females. As noted above, the majority of missing females were 3\textsuperscript{rd} class passengers.
Example Steps

10. By selecting both columns of missing passengers and crew, we can see that the male crew had the lowest chance of survival. By contrast, 1\textsuperscript{st} and 2\textsuperscript{nd} class females had the highest chance of survival.
STATISTICA 3D graphs can be rotated both about horizontal and vertical axes and the distance or “point of view” perspective changed for exploring the distribution of 3D data or for obtaining the best position for clear display of important graph features.
Example 37: Rotating 3D Graphs

1. Create a 3D surface plot. Open the Characteristics.sta data file and select **Surface Plots** from the **Graphs** menu. Select **Age (yr)** as the **X** variable, **Height (in)** as the **Y** variable, and **Weight (lb)** as the **Z** variable. Accept all default options on the **Quick** tab of the **3D Surface Plots** dialog and click **OK** to produce the graph.
Example Steps

2. Click the **3D Rotation Control** toolbar button to display the **Point of View Settings and Exploratory Spin** dialog. Click the **Analytic exploratory spin options** button to set the graph in rotation. Click **OK** when the graph is in a better position. The graph becomes much easier to interpret.
STATISTICA Visual Basic

Takes full advantage of the object model architecture of STATISTICA and allows you to access programmatically every aspect and virtually every detail of the functionality of the program.

Adds an arsenal of more than 10,000 new functions to the standard comprehensive syntax of Microsoft Visual Basic thus comprising one of the largest and richest development environments available.
SVB Macros (Programs)

Use macros

- to automate repetitive work, or
- to automatically generate programs for further editing and modification

3 General Types

- Analysis Macros
- Master (Log) Macros
- Keyboard Macros
Analysis Macros

After selecting any of the statistical commands from the **Statistics** menu or graphics commands from the **Graphs** menu, all actions such as variable selections, option settings, etc. are recorded "behind the scenes." At any time you can then transfer this recording to the **Visual Basic Editor** window.
Master Macros (Logs)

You can record a Master Macro or Master Log of your entire session that can consist of several analyses; this recording will "connect" analyses performed with various analysis options from the Statistics or Graphs menu.
Keyboard Macros

STATISTICA will record the actual keystrokes you enter via the keyboard. When you stop the recording, a STATISTICA Visual Basic editor window will open with typically a very simple program containing a single SendKeys command with symbols that represent all the different keystrokes you performed during the recording session.
Example 38: STATISTICA Visual Basic

For this example, have the output automatically sent to a single workbook. This example will walk you through a simple analysis while the SVB script is being created in the background. There is no need for you to request the recording to begin for an Analysis Macro. You need to request the script, however, when you are done with the analysis in order to save it as a macro to be used in the future.
Example Steps

1. Close all previous analyses and output windows. Open the *Characteristics.sta* data file. From the *Statistics* menu, select *Basic Statistics/Tables*. Select *Correlation matrices* and click *OK*. Click on the *One variable list* button and select *Eye Color* and *Hair Color*. Click *OK*. Click *Summary*. 
Example Steps

2. Resume the analysis and click on the **Advanced/plot** tab. Click on the **3D Histograms** button. Select **Eye Color** for the **First variable list**, and **Hair Color** for the **Second variable list**. Click **OK** to create the graph.

3. The analysis is complete. Now save these steps as a macro. Resume the analysis and click the **Options** button. Select **Create Macro**.
4. When prompted, enter any name into the **Name** field. Click **OK**. After a moment, a **STATISTICA** Visual Basic script will appear in an editing window. Once the code is generated for you, select **Save As** from the **File** menu and save the macro.

5. To test the macro, close all Windows except the spreadsheet and Macro window, and run the macro.

This macro may also be executed on different data files where the user wishes to compute correlations and create a 3D histogram with the second and third variables.
Customizing STATISTICA

STATISTICA “anticipates” your needs in that it remembers various choices as you make them, essentially learning as you go.

- Set both global and local customizations for graphs, spreadsheets, workbooks, reports, etc.,
- Maintain different configurations of STATISTICA (for a single user as well as for network users),
- Define entirely new user interfaces.
Toolbars

- STATISTICA includes a set of toolbars that contain the most needed buttons or special controls for a given task.

- You can create your own toolbars using any combination of buttons or special controls (e.g., font name and size controls, font color controls, or graphics styles).
Getting Help

The STATISTICA Electronic manual provides context-sensitive help as well as examples, overviews, and technical notes.

For more help, see:
- Statistical Advisor
- Animated Overviews
- StatSoft Home Page (www.statsoft.co.za)
- Electronic Statistics Textbook
- StatSoft Technical Support